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Preface

This guide explains how to upgrade your existing Oracle WebLogic Portal installation 
to the latest version of Oracle WebLogic Portal. 

Audience
The tasks described in this guide are typically performed by portal administrators, 
system administrators, and/or database administrators. 

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support 
through My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents
For more information, see the following documents in the WebLogic Portal 
documentation set:

■ Oracle Fusion Middleware Release Notes for Oracle WebLogic Portal

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1Overview of the Upgrade Process to WebLogic 
Portal 10.3.7

This section provides an overview of the strategies and procedures for upgrading 
Oracle WebLogic Portal to 10.3.7. You can upgrade directly to Portal 10.3.7 from the 
following WebLogic Portal applications:

■ Oracle WebLogic Portal 10.3.6

■ Oracle WebLogic Portal 10.3.5

■ Oracle WebLogic Portal 10.3.4

■ Oracle WebLogic Portal 10.3.2

■ Oracle WebLogic Portal 10.3

■ Oracle WebLogic Portal 10.2

Note: If you are upgrading a WLP application that uses Autonomy 
Enterprise Search and you would like to continue to use Autonomy 
Enterprise Search, you must first purchase the required license and 
obtain the binaries from Autonomy Corporation at 
http://www.autonomy.com. For more information on using Autonomy 
with WLP, see Oracle Fusion Middleware Autonomy Search Integration 
Sample Guide for Oracle WebLogic Portal. 

You can also elect to use another search engine in place of 
Autonomy, such as Oracle’s Secure Enterprise Search, which comes 
as part of WebCenter Suite.

The following topics are covered in this chapter:

■ Section 1.1, "Definitions"

■ Section 1.2, "Portal 10.2/10.3/10.3.2/10.3.4/10.3.5/10.3.6 to 10.3.7 Upgrade 
Overview"

■ Section 1.3, "Library Module Changes"

■ Section 1.4, "Event Handling"

Some of tasks associated with a WebLogic Portal upgrade are performed by running 
the WebLogic Upgrade Wizard. The WebLogic Upgrade Wizard is described in Oracle 
Fusion Middleware Upgrade Guide for Oracle WebLogic Server. 
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1.1 Definitions
To clarify the different activities described by this document, a brief list of terms is 
included:

Migration – Moving an application and domain from a third-party technology to an 
Oracle product. (For example, migrating a customer from IBM to Oracle.)

Upgrade – Updating Oracle platform (and components) from older release or Service 
Pack to newer release or Maintenance Pack. This includes updating existing 
application and domain to run in a newer version, for example, 10.2 to 10.3.7.

The process required to upgrade an application environment depends on the scope of 
the application. An application environment includes a WebLogic domain and any 
applications and application resources associated with the domain. It may also include 
external resources, such as firewalls, load balancers, databases, and LDAP servers.

Interoperability – (1) The capability of an application deployed in one release or 
service pack to communicate with another application that is deployed in a different 
release or service pack. (2) The capability of WebLogic Platform components to 
communicate with third-party software using standard protocols.

Compatibility – Application built using one release or Service Pack running in 
another release or Service Pack. This might involve rebuilding the application.

1.2 Portal 10.2/10.3/10.3.2/10.3.4/10.3.5/10.3.6 to 10.3.7 Upgrade Overview
You can upgrade WebLogic Portal release 10.2, 10.3, 10.3.2, 10.3.4, 10.3.5, or 10.3.6 to 
release 10.3.7. The upgrade process involves upgrading the WebLogic Portal domain 
and applications. When upgrading WebLogic Portal, upgrade the portal domain 
before you upgrade portal applications. However, if you are upgrading WebLogic 
Portal 10.3.6 to release 10.3.7, you can optionally choose to upgrade only your portal 
applications, without upgrading your domain. 

The WebLogic Portal APIs have been maintained in the latest version of WebLogic 
Portal (except for the Commerce API, which was deprecated in 10.0 and removed from 
the current version), and most core formats for the database and file-based assets have 
not changed. Where changes have been made, tools are provided to upgrade to the 
new format, or provide manual changes where needed. 

After you upgrade to WebLogic Portal 10.3.7, you cannot go back to a previous portal 
version. When you upgrade, the Derby database version also gets upgraded.

The 10.2/10.3/10.3.2/10.3.4/10.3.5/10.3.6 portal application upgrades are performed 
on a .project file. You can choose one of the following methods to upgrade your 
portal applications to 10.3.7:

■ Open your existing portal application as a workspace in Workshop for WebLogic

■ Import an existing exploded project into Workshop for WebLogic

■ Import an archived project file into Workshop for WebLogic

Tip: You cannot upgrade an existing EAR application; only a project 
can be upgraded.

For information about the upgrade procedures, see Chapter 2, "Upgrading to 
WebLogic Portal 10.3.7." 
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1.3 Library Module Changes
The Domain Upgrader tool is responsible for adding or removing library modules, as 
necessary. It also modifies existing library module path information to point to the 
new product installation.

Removed libraries are deleted from the config.xml file. During upgrade, the module 
version number changes to 10.3.7 in your config.xml file.

1.4 Event Handling
Events can target content to a desired audience. 

Note: Events will fire for a content repository that was upgraded to 
10.3.7 (unless you turned event tracking turned off at the repository 
level). Events can include repository configuration changes, as well as 
content additions, updates, and deletions to the repository.



Event Handling

1-4 Oracle Fusion Middleware Upgrade Guide for Oracle WebLogic Portal



2

Upgrading to WebLogic Portal 10.3.7 2-1

2Upgrading to WebLogic Portal 10.3.7

This chapter describes upgrade tasks related to upgrading your WebLogic Portal 
product to 10.3.7. 

This chapter contains the following sections:

■ Section 2.1, "Database Changes During Upgrade"

■ Section 2.2, "Upgrading WebLogic Portal 10.2/10.3/10.3.2/10.3.4/10.3.5/10.3.6 to 
10.3.7"

■ Section 2.3, "Upgrading from WebLogic Portal 10.3.6 to 10.3.7 Without Upgrading 
the Domain"

2.1 Database Changes During Upgrade
The WebLogic Upgrade Wizard executes database scripts to add and modify database 
tables for WebLogic Portal 10.3.7. Before you run the Upgrade Wizard to perform 
database upgrade tasks, you should perform full backups of all WebLogic Portal 
databases. 

Note: There have been no database schema changes after WebLogic 
Portal release 10.3.2.

Oracle 8.1.7 (DBMS version and drivers) is no longer supported. 
Upgrade to either Oracle 11g or 12c by following your vendor's 
instructions before you upgrade to WebLogic Portal 10.3.7. 

When you run the 10.3.7 Upgrade Wizard, the default is to automatically upgrade the 
main WebLogic Portal database. You can choose to defer database upgrades and do 
that manually. Certain database upgrade tasks, such as dropping deprecated database 
objects, upgrading separate behavior tracking databases, and upgrading separate 
content management databases require a manual database upgrade.

For additional information on how to perform database upgrade tasks manually, see 
Appendix A, "Performing Database Upgrade Tasks Manually".

2.1.1 DDL Files
Table 2–1 lists the .SQL files containing the Data Definition Language (DDL) for the 
database upgrade from WebLogic Portal 10.2/10.3/10.3.2/10.3.4/10.3.5/10.3.6 to 
10.3.7. This information is for reference purpose only. 



Table 2–1  Files Containing the DDL for Upgrading from 10.2/10.3/10.3.2/10.3.4/10.3.5

Directory Name File Name

<WLPORTAL_HOME>/p13n/db/<DBMS> p13n102_create.tables.sql

p13n102_drop.tables.sql 

<WLPORTAL_HOME>/portal/db/<DBMS> pf102_create_tables.sql

pf102_drop_tables.sql

<WLPORTAL_HOME>/content-mgmt/db/<DBMS> cmv102_create_tables.sql
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2.2 Upgrading WebLogic Portal 10.2/10.3/10.3.2/10.3.4/10.3.5/10.3.6 to 
10.3.7

You can upgrade to WebLogic Portal 10.3.7 from the following WebLogic Portal 
versions: 10.2/10.3/10.3.2/10.3.4/10.3.5/10.3.6. The upgrade process requires you to 
upgrade your WebLogic Portal domain and portal applications. Before you upgrade, 
ensure that you back up your applications and data and remove any database objects 
that are not required.

Note: if you are upgrading WebLogic Portal 10.3.6 to release 10.3.7, 
you can choose to upgrade only your portal applications and not the 
WebLogic Portal domain. For information, see Section 2.3, "Upgrading 
from WebLogic Portal 10.3.6 to 10.3.7 Without Upgrading the 
Domain."

This section contains the following topics:

■ Section 2.2.1, "Backing Up Your Applications and Data"

■ Section 2.2.2, "Removing Unneeded Database Objects"

■ Section 2.2.3, "Upgrading Your Portal Domain"

■ Section 2.2.4, "Upgrading WebLogic Portal Applications"

2.2.1 Backing Up Your Applications and Data
Before you upgrade your application environment, you should manually back up the 
domain and any external application and application database resources in a separate 
process. You should back up the relevant information on all machines in the domain. 
The wizard backs up only the domain directory and does not preserve file 
permissions.

2.2.2 Removing Unneeded Database Objects
You can clean up an existing database (any database prior to Portal 10.3.7) that 
contains unused and deprecated/removed WebLogic Commerce Services database 
objects.

Run the following scripts to remove the objects from the database:

■ <WLPORTAL_HOME>/portal/db/<DBMS>/wlcs_drop_fkeys.sql

■ <WLPORTAL_HOME>/portal/db/<DBMS>/wlcs_drop_tables.sql
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2.2.3 Upgrading Your Portal Domain
This section provides upgrade instructions for WebLogic Portal database and metadata 
files. 

As you prepare to upgrade your portal application, review the Oracle Enterprise Pack 
for Eclipse upgrade documentation available by choosing Help > Help Contents > 
Oracle Workshop for WebLogic User's Guide > Upgrading to Workshop for 
WebLogic 10.x. The Oracle Enterprise Pack for Eclipse documentation includes 
step-by-step instructions for using the Import Wizard, and detailed information about 
what happens during the upgrade process and any required manual pre- or 
post-upgrade tasks.

Perform the following steps to upgrade your portal domain:

1. Verify that the WebLogic domain is not running.

2. Upgrade the portal domain using the WebLogic Upgrade Wizard before you 
upgrade your portal application. To start the WebLogic Upgrade Wizard in 
graphical mode and upgrade a WebLogic domain on a Windows platform, run 
upgrade.cmd from the <WLPORTAL_HOME>\common\bin directory

Note: Do not use the menu option Start > All Programs > Oracle 
Products > WebLogic Server 10.x > Tools > Domain Upgrade Wizard. 
This launches the WebLogic Server domain upgrade wizard. 

Note: The WebLogic Upgrade Wizard is described in detail in Oracle 
Fusion Middleware Upgrade Guide for Oracle WebLogic Server. 

The wizard upgrades your portal, content management, and personalization 
database data.

3. In <WL_DOMAIN>/config/config.xml file, ensure that the entries correctly point to 
your upgraded WebLogic Portal domain path and that the release number is 
correct (10.3.7). 

Note: Weblogic Portal 10.3.7 uses WebLogic Server 10.3.6. All 
config.xml entries must point to WebLogic Portal release 10.3.7. 
However the following two entries must point to WebLogic Server 
release 10.3.6:

■ "<domain-version>10.3.6.0</domain-version>"

■ "<configuration-version>10.3.6.0</configuration-version>"

For entries in config.xml, sample codes are shown below, which point to release 
10.3.7. 

■ content-management-cmis-base-web-lib

  <library>
    <name>content-management-cmis-base-web-lib#10.3.7@10.3.7</name>
    <target>AdminServer</target>
    <source-path><<WLPORTAL_HOME>>/../modules/com.bea.content.cmis.rest_
10.3.7.0/content-management-cmis-base-web-lib.war</source-path>
    <deployment-order>1</deployment-order>
    <security-dd-model>DDOnly</security-dd-model>
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  </library>

  <library>
    <name>content-management-cmis-base-web-lib#10.3.7@10.3.7.1</name>
    <target>AdminServer</target>
    <source-path>><<WLPORTAL_HOME>>/../modules/com.bea.content.cmis.rest_
10.3.7.0/maintenance\1037\default\content-management-cmis-base-web-lib.war<
/source-path>
    <deployment-order>1</deployment-order>
    <security-dd-model>DDOnly</security-dd-model>
  </library>

■ content-management-cmis-rest-app-lib

<library>
    <name>content-management-cmis-rest-app-lib#10.3.7@10.3.7</name>
    <target>AdminServer</target>
    <module-type>ear</module-type>
    <source-path><<WLPORTAL_HOME>>/../modules/com.bea.content.cmis.rest_
10.3.7.0/content-management-cmis-rest-app-lib.ear</source-path>
    <security-dd-model>DDOnly</security-dd-model>
  </library>

  <library>
    <name>content-management-cmis-rest-app-lib#10.3.7@10.3.7.1</name>
    <target>AdminServer</target>
    <source-path><<WLPORTAL_HOME>>/../modules/com.bea.content.cmis.rest_
10.3.7.0/maintenance\1037\default\content-management-cmis-rest-app-lib.ear<
/source-path>
    <deployment-order>1</deployment-order>
    <security-dd-model>DDOnly</security-dd-model>
  </library>

■ content-management-cmis-rest-web-lib

<library>
    <name>content-management-cmis-rest-web-lib#10.3.7@10.3.7</name>
    <target>AdminServer</target>
    <source-path><<WLPORTAL_HOME>>/../modules/com.bea.content.cmis.rest_
10.3.7.0/content-management-cmis-rest-web-lib.war</source-path>
    <deployment-order>1</deployment-order>
    <security-dd-model>DDOnly</security-dd-model>
  </library>

<library>
    <name>content-management-cmis-rest-web-lib#10.3.7@10.3.7.1</name>
    <target>AdminServer</target>
    <source-path><<WLPORTAL_HOME>>/../modules/com.bea.content.cmis.rest_
10.3.7.0/maintenance\1037\default\content-management-cmis-rest-web-lib.war<
/source-path>
    <deployment-order>1</deployment-order>
    <security-dd-model>DDOnly</security-dd-model>
  </library>

■ content-management-faces-web-lib

  <library>
    <name>content-management-faces-web-lib#10.3.7@10.3.7</name>
    <target>AdminServer</target>
    <source-path><<WLPORTAL_HOME>>/../modules/com.bea.content.vcr_
10.3.7.0/content-management-faces-web-lib.war</source-path>
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    <deployment-order>1</deployment-order>
    <security-dd-model>DDOnly</security-dd-model>
  </library>

<library>
    <name>content-management-faces-web-lib#10.3.7@10.3.7.1</name>
    <target>AdminServer</target>
    <source-path><<WLPORTAL_HOME>>/../modules/com.bea.content.vcr_
10.3.7.0/maintenance\1037\default\content-management-faces-web-lib.war</sou
rce-path>
    <deployment-order>1</deployment-order>
    <security-dd-model>DDOnly</security-dd-model>
  </library>

■ content-management-web-lib

<library>
    <name>content-management-web-lib#10.3.7@10.3.7</name>
    <target>AdminServer</target>
    <source-path><<WLPORTAL_HOME>>/../modules/com.bea.content.vcr_
10.3.7.0/content-management-web-lib.war</source-path>
    <deployment-order>1</deployment-order>
    <security-dd-model>DDOnly</security-dd-model>
  </library>

  <library>
    <name>content-management-web-lib#10.3.7@10.3.7.1</name>
    <target>AdminServer</target>
    <source-path><<WLPORTAL_HOME>>/../modules/com.bea.content.vcr_
10.3.7.0/maintenance\1037\default\content-management-web-lib.war</source-pa
th>
    <deployment-order>1</deployment-order>
    <security-dd-model>DDOnly</security-dd-model>
  </library>

■ p13n-app-lib-base

<library>
    <name>p13n-app-lib-base#10.3.7@10.3.7</name>
    <target>AdminServer</target>
    <source-path><<WLPORTAL_HOME>>/../modules/com.bea.p13n_
10.3.7.0/p13n-app-lib-base.ear</source-path>
    <deployment-order>1</deployment-order>
    <security-dd-model>DDOnly</security-dd-model>
  </library>

  <library>
    <name>p13n-app-lib-base#10.3.7@10.3.7.1</name>
    <target>AdminServer</target>
    <source-path><<WLPORTAL_HOME>>/../modules/com.bea.p13n_
10.3.7.0/maintenance\1037\default\p13n-app-lib-base.ear</source-path>
    <deployment-order>1</deployment-order>
    <security-dd-model>DDOnly</security-dd-model>
  </library>

■ p13n-core-web-lib

  <library>
    <name>p13n-core-web-lib#10.3.7@10.3.7</name>
    <target>AdminServer</target>
    <source-path><<WLPORTAL_HOME>>/../modules/com.bea.p13n_
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10.3.7.0/p13n-core-web-lib.war</source-path>
    <deployment-order>1</deployment-order>
    <security-dd-model>DDOnly</security-dd-model>
  </library>

  <library>
    <name>p13n-core-web-lib#10.3.7@10.3.7.1</name>
    <target>AdminServer</target>
    <source-path><<WLPORTAL_HOME>>/../modules/com.bea.p13n_
10.3.7.0/maintenance\1037\default\p13n-core-web-lib.war</source-path>
    <deployment-order>1</deployment-order>
    <security-dd-model>DDOnly</security-dd-model>
  </library>

■ vcr-app-lib

  <library>
    <name>vcr-app-lib#10.3.7@10.3.7</name>
    <target>AdminServer</target>
    <source-path><<WLPORTAL_HOME>>/../modules/com.bea.content.vcr_
10.3.7.0/vcr-app-lib.ear</source-path>
    <deployment-order>1</deployment-order>
    <security-dd-model>DDOnly</security-dd-model>
  </library>

  <library>
    <name>vcr-app-lib#10.3.7@10.3.7.1</name>
    <target>AdminServer</target>
    <source-path><<WLPORTAL_HOME>>/../modules/com.bea.content.vcr_
10.3.7.0/maintenance\1037\default\vcr-app-lib.ear</source-path>
    <deployment-order>1</deployment-order>
    <security-dd-model>DDOnly</security-dd-model>
  </library>

Tip: If you customized how you set the domain in your start scripts, 
your changes will be overwritten when you run the WebLogic Portal 
10.3.7 start scripts. You should manually copy any start script (and 
setDomainEnv.cmd/sh) modifications you made and want to preserve 
in the upgraded domain.

Note: If you are using the RDBMS Security Store feature, as part of 
the upgrade process, the DDL automatically creates the RDBMS 
Security Store tables in the schema for which the p13nDatasource is 
configured. If a portal domain administrator wishes to use or 
configure a database schema other than the schema for which the 
p13nDatasource is configured, he or she must manually run the 
following script to create the RDBMS Security Store tables for that 
schema:

<WLPORTAL_HOME>/p13n/db/<database_vendor>/rdbms_security_
store_create_tables.sql 

For more information on the RDBMS Security Store tables, see 
"RDBMS Security Store Tables" in the Oracle Fusion Middleware 
Database Administration Guide for Oracle WebLogic Portal.
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2.2.4 Upgrading WebLogic Portal Applications
The upgrade process involves upgrading WebLogic Portal applications and resources 
to WebLogic Portal 10.3.7. Upgrades are performed on the Eclipse project folder. After 
you upgrade to WebLogic Portal 10.3.7, you cannot go back to a previous portal 
version.

Choose one of the following ways to upgrade your portal application to 10.3.7:

■ Open an existing portal application as a workspace in Eclipse.

■ Import an existing exploded project into Eclipse.

■ Import an archived project file into Eclipse.

Tip: You cannot upgrade an existing EAR application; only a project 
can be upgraded.

You can choose to point your upgraded application to a new or 
upgraded 10.3.7 domain.

Perform the following steps to upgrade a WebLogic Portal application to release 10.3.7:

1. In Oracle Enterprise Pack for Eclipse, ensure that Project > Build Automatically is 
enabled to resolve any build errors. By default, it is enabled.

2. As needed, upgrade individual applications as described in Oracle Fusion 
Middleware Production Operations Guide for Oracle WebLogic Portal.

2.3 Upgrading from WebLogic Portal 10.3.6 to 10.3.7 Without Upgrading 
the Domain

Weblogic Portal 10.3.7 uses WebLogic Server 10.3.6, and the core format of the 
database is same as Weblogic Portal 10.3.6. When upgrading from Weblogic Portal 
10.3.6, you can optionally choose to create a new WebLogic domain and upgrade only 
WebLogic Portal applications without upgrading the Weblogic domain or database.

Perform the following steps to upgrade WebLogic Portal 10.3.6 to 10.3.7 without 
upgrading the domain:

1. Install WebLogic Portal 10.3.7. For more information, see Installing WebLogic 
Portal.

2. Back up the database associated with WebLogic Portal 10.3.6. For more 
information, see Section 2.2.1, "Backing Up Your Applications and Data."

3. Create a new WebLogic domain using WebLogic Portal 10.3.7. For more 
information, see WebLogic Domain Configuration Wizard.

Note: While creating the WebLogic domain, do not execute database 
scripts, but you can specify the database details associated with 
Weblogic Portal 10.3.6 in the Configure JDBC Data Sources page.

4. If you did not specify database details in the previous step, configure the newly 
created WebLogic domain for the database and schema associated with WebLogic 
Portal 10.3.6 using the WebLogic console. For information, see JDBC Data Source: 
Configuration: Connection Pool.

5. Import the project into a new workspace using WebLogic Portal 10.3.7. For more 
information, see Section 2.2.4, "Upgrading WebLogic Portal Applications."
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6. Point your upgraded application to a new domain.

7. Log in to WebLogic Portal 10.3.7 and verify your applications.
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APerforming Database Upgrade Tasks Manually

This appendix describes how to perform database upgrade tasks manually if you do 
not use the WebLogic Upgrade Wizard to upgrade from WebLogic Portal 
10.2/10.3/10.3.2/10.3.4/10.3.5/10.3.6 to release 10.3.7.

See the README.txt file and the upgrade_db.properties file in the <WLPORTAL_
HOME>\common\lib\upgrade\db directory for detailed information about the files used 
in the upgrade and specific upgrade steps.

This appendix contains the following sections:

■ Appendix A.1, "Upgrading your Main WebLogic Portal 
10.2/10.3/10.3.2/10.3.4/10.3.5/10.3.6 Database"

■ Appendix A.2, "Dropping Deprecated Compoze Database Tables After Upgrade"

A.1 Upgrading your Main WebLogic Portal 
10.2/10.3/10.3.2/10.3.4/10.3.5/10.3.6 Database 

If you did not upgrade your main WebLogic Portal database from 
10.2/10.3/10.3.2/10.3.4/10.3.5/10.3.6 to 10.3.7 using the WebLogic Upgrade Wizard, 
you can perform the upgrade manually. 

Note: As part of the upgrade process, the DDL automatically creates 
the RDBMS Security Store tables in the schema for which the 
p13nDatasource is configured. If a portal domain administrator 
wishes to use or configure a database schema other than the schema 
for which the p13nDatasource is configured, he or she must manually 
run the following script to create the RDBMS Security Store tables for 
that schema:

<WLPORTAL_HOME>/p13n/db/<database_vendor>/rdbms_security_
store_create_tables.sql 

For more information on the RDBMS Security Store tables, see 
"RDBMS Security Store Tables" in the Oracle Fusion Middleware 
Database Administration Guide for Oracle WebLogic Portal.

Perform the following steps to upgrade your WebLogic Portal database:

1. Shut down WebLogic Server.

2. Back up your database data as described by your database vendor.
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3. Edit the <WLPORTAL_HOME>\common\lib\upgrade\db\upgrade_db.properties file 
for your database environment. Replace the @ symbols and the text between the 
symbols with the correct values for @DB_USER@, @DB_PASSWORD@, @DB_HOST@, @DB_
PORT@, and @DB_NAME@.

4. In the upgrade_db.properties file, modify and uncomment the files= setting for 
your portal database. Follow the instructions in the upgrade_db.properties file 
for your specific type of upgrade.

5. Run the following script: upgrade_db.cmd/.sh.

A.2 Dropping Deprecated Compoze Database Tables After Upgrade
After you upgrade to WebLogic Portal 10.3.7, you can drop the tables associated with 
Compoze/Collaboration using the following script:

<WLPORTAL_HOME>\portal\db\<DMBS>\dep9_drop_tables.sql
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